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KEY FINDINGS 
 

 Intel vPro Technology-based desktop 
platforms yielded significant performance 
advantages for users simultaneously 
running productivity, collaboration, and other 
tasks, and these platforms were the fastest 
in all tests. 

 The Intel vPro Technology-based PC with 
the Intel Core 2 Duo Processor E6700 
finished our tasks on average 2.12 times 
faster than the Intel Pentium 4 630 
Processor-based PC and 1.68 times faster 
than the Intel Pentium D 930 Processor-
based PC. 

 The Intel vPro Technology-based PC with 
the Intel Core 2 Duo Processor E6300 
finished our tasks on average 1.70 times 
faster than the Intel Pentium 4 630 
Processor-based PC and 1.34 times faster 
than the Intel Pentium D 930 Processor-
based PC. 

 These performance improvements translate 
into multi-second time savings that would be 
noticeable to users. 

Executive summary 
Intel® Corporation (Intel) commissioned Principled 
Technologies (PT) to compare the performance in common 
business multitasking scenarios of Intel® vPro™ technology 
platforms with that of two other earlier platforms. We ran a 
range of typical enterprise multitasking scenarios that 
involve real-time communication and collaboration with 
Microsoft Office Communicator 2005 and other common 
office applications, on four different Intel processor/platform 
combinations: 
 

• Intel Pentium® 4 630 Processor-based PC (3.0 
GHz) supporting Hyper-Threading Technology (HT) 
on the Intel D945GTP desktop board (with the Intel 
i945G Express chipset) 

• Intel Pentium D 930 Processor-based PC 
(3.0GHz Dual-Core processor) on the Intel 
D945GTP desktop board (with the Intel i945G 
Express chipset) 

• Intel vPro Technology-based PC with Intel 
Core™ 2 Duo Processor E6300 (1.86GHz Dual-
Core) on Intel DQ965WC desktop board (with the 
Intel Q965 Express chipset) 

• Intel vPro Technology-based PC with Intel Core 
2 Duo Processor E6700 (2.66GHz Dual-Core) on 
Intel DQ965WC desktop board (with the Intel Q965 
Express chipset) 

 
We selected four 
scenarios and created 
scripts that allowed us 
to automate our 
testing. Though each 
scenario involved 
collaboration or 
productivity functions 
that use typical 
enterprise office 
applications, we 
varied the number, 
type, and 
computational 
intensity of the tasks 
to reflect a range of 
user experiences.  
 
As Figure 1 shows, 
both Intel vPro 
Technology-based 
PCs significantly 

Overall Relative Performance
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6300 averages 70% faster 
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6700 averages 112% faster 
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Figure 1: Overall average performance, relative to the Intel Pentium 4 630 Processor-based 
system, on all foreground and background tasks on all four systems. Average performance is 
the geometric mean of the normalized time for each task. Higher numbers are better. 
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outperformed the Intel Pentium 4 630 Processor-based PC and the Intel Pentium D 930 Processor-based PC on 
all our tasks. Compared to the Intel Pentium 4 630 Processor-based PC, the Intel vPro Technology-based PC 
with Intel Core 2 Duo Processor E6700 was from 1.41 times to 3.37 times faster on different applications and 
tasks and averaged 2.12 times faster across all the tasks. (In all comparisons in which we cite the average of task 
times, we use the geometric mean of the normalized times for each task.) Compared to that same Pentium 4 630 
Processor-based PC, the Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 was from 
1.13 to 2.69 times faster on our tests and averaged 1.70 times faster  
 
Compared to the Intel Pentium D 930 Processor-based PC, the Intel vPro Technology-based PC with the Intel 
Core 2 Duo Processor E6700 was from 1.22 to 2.82 times faster on different applications and tasks and averaged 
1.68 times faster. Compared to that same system, the Intel vPro Technology-based PC with the Intel Core 2 Duo 
Processor E6300 was up to 2.17 times faster and averaged 1.34 times faster.  
 
These performance improvements translated into multi-second time savings noticeable to users. The longest task 
took 294.9 seconds on the Intel Pentium 4 630 Processor-based PC but only 120.7 seconds--almost two and a 
half minutes faster--on the Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6700. The 
shortest task took 4.5 seconds on the Intel Pentium 4 630 Processor-based PC but only 3.2 seconds on the Intel 
vPro Technology-based PC with the Intel Core 2 Duo Processor E6700.  
 
So that we could make the four test systems as similar as reasonably possible while varying the processors and 
motherboards, we built the systems rather than purchasing them from vendors. Intel specified the general system 
types and supplied the processors and motherboards. We purchased common such components as RAM, hard 
disks, and optical drives. Each test system had the following basic components (see Appendix A for detailed 
configuration information):  

 
• 1GB of the fastest RAM its motherboard supported 
• 300GB hard disk with an 8MB buffer (SATA)  
• DVD-RW optical drive  
• Microsoft Windows XP Professional (Service Pack 2) 

 
We used the following common enterprise collaboration and productivity applications, which we list in alphabetical 
order:  
 

• Adobe Acrobat 7.0 Standard Version 7.0.8 
• Microsoft Office Communicator 2005 (Trial edition) 
• Microsoft Office Excel 2003 (Service Pack 2) 
• Microsoft Office Outlook 2003 (Service Pack 2) 
• Microsoft Office PowerPoint 2003 (Service Pack 2) 
• Microsoft Office Word 2003 (Service Pack 2) 
 

 
We also used the following common enterprise security applications, which we list in alphabetical order: 
 

• McAfee VirusScan Enterprise 8.0i 
• Webroot Spy Sweeper version 4.5.9 (build 709) using Spyware Definitions v 745 (14-day trial)  

 
The application scenarios we tested included such common functions as: 
 

• Opening files 
• Recalculating Excel spreadsheets 
• Converting documents to .PDF format 
• Sending files 
• Sending email 
• Starting a whiteboard-sharing session 
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• Making a VoIP one-to-one call 
• Scanning for viruses 
• Scanning for spyware 

 
To make it easier to test our scenarios repeatedly and accurately, we automated the hand-timed application 
functions using scripts we wrote in IBM’s Rational Visual Test 6.5. In our analyses we used the times from our 
tests of those scripts.  
 
In the following sections we look more closely at our test application scenarios (Application scenarios), examine 
the results of our tests (Test results and analysis), and give detailed information about how we actually performed 
the tests (Test methodology). In the appendices, we present the configurations of the test systems, explain how to 
manually execute the application functions in our scenarios, and discuss some potential issues in the 
development of the test scripts. 
 
Application scenarios 
To assess platform performance on typical user activities involving collaboration and productivity applications, we 
developed a set of multitasking scenarios that employ leading collaboration, productivity, and security 
applications. We focused primarily on processor-intensive operations that often force users to wait, because users 
are likely to appreciate performance improvements on such operations. 
 
Each scenario contains two to three timed tasks. Tasks are a combination of background computing tasks and 
foreground applications. Background computing tasks are typically activities that run unattended while users are 
performing other functions. In our scenarios, security functions such as virus and spyware scans are 
backgrounds, as are other lengthy tasks on which users would be unlikely to wait. A foreground task is one whose 
completion users will typically await before moving to the next task. Some of our scenarios include multiple 
background tasks. In our results graphs and tables, we label each task as either FG (foreground) or BG 
(background). 
 
Two of our scenarios include collaboration tasks using Microsoft Office Communicator version 1.0 as well as 
common business applications. The other two include productivity tasks using Microsoft Office and Adobe 
applications, as well as some security-related programs.  

Sharing data for a sales report 
In the first scenario, Hannah, a business manager, needs to share some data that her team is using to develop a 
sales report. Like everyone else in her organization, she has McAfee VirusScan installed on her system, where it 
scans files as she opens them. Hannah has already exported sales data from Microsoft Access into an XML 
report. She now needs to get this report to Lily, a colleague who works at another location, so that Lily can use 
data from it in her section of the sales report. Due to the size of the file (68.5MB) Hannah decides to send Lily the 
file via Office Communicator’s Send File Command rather than email it; the process begins with a transfer request 
from Hannah to Lily. Hannah also needs to copy charts into the sales report from an Excel spreadsheet that she 
has set up for manual calculation. Before Hannah starts work with the Excel file, Lily accepts the file transfer 
request, and the transfer starts. That transfer runs in the background while Hannah proceeds with her work. 
Hannah presses F9 in Excel to start the Excel calculation task. While the 2.56MB Excel spreadsheet is 
calculating, Hannah starts an e-mail message in Office Communicator to Otto, a marketing manager, to ask him 
to recommend titles for the sales report and charts. 
 
We timed: 
 

• the Excel task (BG) from when Hannah presses F9 until the calculation finishes and the status bar in 
Excel states that the file is Ready 

• the file transfer (BG) from the start of the transfer until the Office Communicator status window shows 
the transfer is complete 

• the email task (FG) from the time Hannah presses OK on the Send E-Mail dialog in Office 
Communicator until the new email message displays 
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The McAfee VirusScan background is not a separate task but does stress the system by automatically checking 
files when appropriate.  

Preparing slides for a customer presentation 
In our second scenario, Bert, an analyst in a marketing department, is preparing a PowerPoint deck for a 
customer presentation. He can get the data he needs for a new slide by calculating subtotals in an Excel 
spreadsheet. He has the Excel file open and has highlighted all the data on a worksheet that has 11,511 rows of 
sales data in 11 columns. Bert selects Data>Subtotals from the Excel menu, and the Subtotals dialog displays 
and fills in information on the subtotal he needs. Because the spreadsheet already displays another subtotal that 
he finds useful, he unchecks the Replace current subtotals field. He then presses Enter to start the subtotals task. 
While that task is underway, Bert opens the 33.5MB, 36-slide PowerPoint file. The file doesn’t open in the slide 
sorter view he prefers, so he selects View>Slide Sorter from the PowerPoint menu to change the view.  
 
We timed: 
 

• the Excel task (BG) from the time Bert presses Enter to start the task until Excel displays a Ready 
message when it finishes the task 

• the PowerPoint task (part of the FG task) from the beginning of the open until all the slide thumbnails 
display in PowerPoint 

• the change view task (the other part of the FG task) from when Bert selects View>Slide Sorter from 
the PowerPoint menu until PowerPoint finishes displaying the slides.  

 
We combine the times for these two consecutive foreground activities in our results presentation, because to most 
users they would happen automatically enough that they would feel like a single interaction with PowerPoint. 

Collaborating on product development 
In the third scenario, Nan, a developer, is collaborating with a team member, Emme, on an Office Communicator 
1:1 Voice over Internet Protocol (VoIP) call to discuss an upcoming product launch. Nan has a 2.88MB Excel 
spreadsheet of product data that Emme would like her to convert to PDF format and send. Before Nan can start 
the conversion, a Spy Sweeper scan that the IT department scheduled starts. While the scan runs, Nan chooses 
Select Adobe PDF>Convert to Adobe PDF from the Excel menu to start the PDF conversion. When the Save 
Adobe PDF File As dialog displays, Nan presses Save to create the PDF with the default file name. While both 
the Spy Sweeper scan and the Adobe PDF conversion run in the background, Nan continues talking with Emme 
and opens an 11MB, 42-page XML file in Word that she will use as she and Emme move to their next topic.  
 
We timed: 
 

• the Spy Sweeper scan (BG) from when the scan begins until Spy Sweeper finishes it and displays a 
results window 

• the PDF conversion (BG) from the time Nan presses the Save button in Excel until the new PDF file 
opens on her screen 

• the Word XML file open (FG) from the time Nan starts the open until Word displays the document and 
updates the page count on the Word status bar 

 
We do not time the VoIP call because it is going on throughout the scenario and the user, not the platform, 
determines its duration. 

Collaborating on a marketing campaign presentation 
In the fourth scenario, Anna, a marketing manager, is putting the final touches on a presentation for a campaign 
she is developing. Before making the presentation, she needs to review her ideas with another member of her 
team, Bob. She plans to use the Office Communicator whiteboard during the call with Bob to sketch out her ideas, 
and she will need to consult a large, 8.18MB, 42-page Microsoft Word document containing the product 
specification. When it’s time for her to make the call using Office Communicator, an automatic virus scan 
scheduled by the IT department begins. While the scan is running, Anna opens the document in Word and starts 
a whiteboard sharing session in Office Communicator.  
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Figure 2: Median test times, in seconds, for all four test systems on all four scenarios. Lower numbers are better.  

 
We timed: 
 

• the virus scan (BG) from the time the scan window opens until it closes at the end of the scan 
• the Word file open (BG) from when Anna launches Microsoft Word until Word displays the document 

and updates the page count for the document in the Word status bar 
• the whiteboard sharing initialization (FG) from when Anna presses OK to start the sharing until the 

sharing window opens 
 
For more details on how we executed and measured these scenarios, our specific test functions, and the files the 
scenarios use, see Appendix B. 
 
Test results and analysis  
In this section we examine the results of each of our tests. Figure 2 shows the times, in seconds, that each test 
system needed to complete each scenario. The times we show for each platform for each scenario are from the 
median run of the five test runs of that scenario on that platform. (We defined the median run as the one with the 
median sum of the times of its timed tasks.) 
 

Tests 

Intel 
Pentium 4 
630 
Processor-
based PC  

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology-
based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology-
based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

Sharing data for a sales report 
Microsoft Office Communicator open email (FG) 14.0 11.3 5.2 4.2 
Microsoft Office Communicator send file (BG) 15.9 13.1 9.1 8.9 
Microsoft Excel recalc (BG) 17.2 14.4 7.9 5.1 
Preparing slides for a customer presentation 
Microsoft PowerPoint file open and change view (FG) 22.1 15.6 13.8 11.0 
Microsoft Excel subtotals (BG) 24.5 15.6 12.4 8.3 
Collaborating on product development 
Microsoft Word Open XML file (FG) 12.5 11.4 10.3 8.4 
Microsoft Excel spreadsheet to Adobe PDF conversion (BG) 69.5 40.5 31.8 24.7 
Webroot Spy Sweeper scan (BG) 294.9 265.5 169.7 120.7 
Collaborating on a marketing campaign presentation 
Microsoft Office Communicator start sharing (FG) 4.5 4.0 4.0 3.2 
Microsoft Word file open (BG) 16.4 14.5 12.2 11.0 
McAfee virus scan (BG) 39.4 31.7 26.8 25.9 

 
 
In the following sub-sections we explore these results in more detail. To make comparisons easier, we always 
show results normalized to those of the slowest system in the group, the Intel Pentium 4 630 Processor-based 
PC. To compute those normalized results, we divided each system’s time by the time it took the system with the 
Intel Pentium 4 630 Processor-based PC to perform the same task. The result for the Intel Pentium 4 630 
Processor-based PC is thus always 1.00, because it’s the comparison basis. Results higher than 1.00 indicate 
how much faster a system is than that system. Because of the normalization, higher result numbers are better. 
For example, a result of 1.80 would mean the system in question was 80 percent faster than the Intel Pentium 4 
630 Processor-based PC. 
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As part of our discussion of each scenario, we also show processor utilization curves that we captured with 
Windows XP’s Perfmon utility. In all the processor utilization charts, we use a blue line for foreground tasks and a 
red line for background tasks. We use these charts to illustrate how demanding each task would be if we ran it 
alone. In multitasking scenarios, the system faces each of these same demands, but all at the same time, 
because the tasks run simultaneously. When each of the simultaneous tasks has minimal processor 
requirements, keeping them all executing smoothly in parallel may not be difficult. When one or more of the tasks 
has significant processor demands, meeting those demands at the same time can be extremely difficult for a 
processor without the added execution ability of the Intel Core 2 Duo Processor. We captured each task’s 
processor-demand curve on the Intel Pentium 4 630 Processor-based PC with HT Technology disabled. We 
chose to capture this data on this system with HT Technology disabled to make it easy to see the processor 
demands; had we captured the processor utilization with HT Technology enabled or on one of the Dual-Core 
based systems, Perfmon would have capped each logical core at 50 percent utilization. (When we ran the 
scenarios on Intel Pentium 4 630 Processor-based PC, we of course took full advantage of the power of that 
system and had HT Technology enabled.) 
 

Sharing data for a sales report 
This scenario sends a 68.5MB XML file to another user via Office Communicator (the first background task) and 
then sends an email message via Office Communicator (the foreground task), while recalculating a function-rich, 
2.56MB Excel spreadsheet (the second background task). As figures 3 and 4 show, the Intel vPro Technology-
based PC with the Intel Core 2 Duo Processor E6700 is 3.33 times faster on the foreground task, 1.79 times 
faster on the first background task, and 3.37 times faster than the Intel Pentium 4 630 Processor-based PC on the 
second background task,  
 
The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 also shows large performance 
improvements, coming in at 2.69 times faster on the foreground task than the Intel Pentium 4 630 Processor-
based PC and 1.75 and 2.18 times faster on the two background tasks. 
 
Figure 3 also demonstrates that both Intel vPro Technology-based PCs delivered better performance than the 
Intel Pentium D 930 Processor-based PC: the Intel vPro Technology-based PC with the Intel Core 2 Duo 
Processor E6700 averaged 2.24 times faster on the three tasks, and the Intel vPro Technology-based PC with the 
Intel Core 2 Duo Processor E6300 averaged 1.79 times faster. 

 
As Figure 4 shows, 
these differences 
represent significant 
improvements in the 
time it takes to 
perform each task. 
Compared to the Intel 
Pentium 4 630 
Processor-based PC, 
the Intel vPro 
Technology-based PC 
with the Intel Core 2 
Duo Processor E6700 
decreased the 
elapsed time from 
14.0 to 4.2 on the 
foreground task, from 
15.9 to 8.9 seconds 
on the first 
background task, and 
from 17.2 to 5.1 
seconds on the 

Figure 3: Performance, relative to the Intel Pentium 4 630 Processor-based PC, of each of the four 
systems sharing data for a sales report. Larger numbers represent better performance. 

Sharing data for a sales report
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6300 averages 117% faster 
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6700 averages 172% faster 
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second background task. The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 also 
showed significant gains over the Intel Pentium 4 630 Processor-based PC, completing the foreground task 8.8 
seconds faster, the first background task 6.8 seconds faster, and the second background task 9.3 seconds faster. 
 

PERFORMANCE RESULTS (seconds) COMPARATIVE RATING 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

TASKS 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

14.0 11.3 5.2 4.2 
Microsoft Office 
Communicator 
open email (FG) 

1.00 1.24 2.69 3.33 

15.9 13.1 9.1 8.9 
Microsoft Office 
Communicator send 
file (BG) 

1.00 1.21 1.75 1.79 

17.2 14.4 7.9 5.1 Microsoft Excel 
recalc (BG) 1.00 1.19 2.18 3.37 

 
 
The processor utilization curves in figures 5, 6, and 7 help identify a key reason for these time savings. As they 
show, each of the scenario’s tasks has very high processor demands and so benefits heavily from the Intel vPro 
architecture and the Intel Core 2 Duo processors. The Excel background task demands the full processor most of 
the time, while the send file background task wants 60 percent or more of the processor for most of its duration. 
The foreground task demands 40 percent or more of the processor for most of its run. 
 
 
 
 
 
 
 
 
 
 

Figure 4: Results for each of the four systems sharing data for a sales report. Lower performance results are better. 
Higher comparative ratings are better.  
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Figure 5: System processor utilization of the Microsoft Excel 
recalc background task running alone on the Intel Pentium 4 
630 Processor-based PC with HT Technology disabled. 
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Figure 6: System processor utilization of the Microsoft 
Office Communicator send file background task running 
alone on the Intel Pentium 4 630 Processor-based PC with 
HT Technology disabled.
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Preparing slides for a customer presentation 
In this scenario, two tasks run concurrently. The scenario opens a 33.5MB Microsoft PowerPoint presentation and 
changes the display to slide sorter view (the two actions together constitute the foreground task) while a 1.79MB 
Microsoft Excel spreadsheet calculates subtotals (the background task). 
 
As Figure 8 illustrates, the Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6700 was 2.01 
times faster on the foreground task and 2.95 times faster on the background task than the Intel Pentium 4 630 
Processor-based PC. The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 also 
yielded large performance improvements, coming in at 1.60 times faster on the foreground task and 1.98 times 
faster on the background task than the Intel Pentium 4 630 Processor-based PC.  
 
The Intel vPro-Technology-based PCs also out-performed the Intel Pentium D 930 Processor-based PC. The Intel 

vPro Technology-
based PC with the 
Intel Core 2 Duo 
Processor E6700 
averaged 1.63 times 
faster on the two 
tasks, and the Intel 
vPro Technology-
based PC with the 
Intel Core 2 Duo 
Processor E6300 
averaged 1.19 times 
faster.  
 
Figure 9 
demonstrates that 
these differences 
represent significant 
improvements in the 
time it took to perform 
each task. Compared 
to the Intel Pentium 4 
630 Processor-based 
PC, the Intel vPro 

Figure 8: Performance, relative to the Intel Pentium 4 630 Processor-based PC, of each of the four 
systems preparing slides for a customer presentation. Larger numbers represent better 
performance.

Preparing slides for a customer presentation
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6300 averages 78% faster 
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6700 averages 144% faster 
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Figure 7: System processor utilization of the Microsoft 
Office Communicator send email foreground task running 
alone on the Intel Pentium 4 630 Processor-based PC with 
HT Technology disabled. 
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Technology-based PC with the Intel Core 2 Duo Processor E6700 cut the elapsed time from 22.1 to 11.0 seconds 
on the foreground task and from 24.5 to 8.3 seconds on the background task. The Intel vPro Technology-based 
PC with the Intel Core 2 Duo Processor E6300 also significantly beat the Intel Pentium 4 630 Processor-based 
PC, running 8.3 seconds faster on the foreground task and 12.1 seconds faster on the background task. 
 

PERFORMANCE RESULTS (seconds) COMPARATIVE RATING 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

TASKS 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

22.1 15.6 13.8 11.0 

Microsoft 
PowerPoint file 
open and change 
view (FG) 1.00 1.42 1.60 2.01 

24.5 15.6 12.4 8.3 
Microsoft Excel 
subtotals (BG) 1.00 1.57 1.98 2.95 

 
 
The Intel vPro Technology-based PCs with Intel Core 2 Duo Processors are able to handle this scenario’s 
processor-intensive tasks with ease. The processor utilization curves in figures 10, 11, and 12 help illustrate the 
reason for these time savings. For this analysis, we separated the PowerPoint open and the PowerPoint change 
view functions into two figures to identify the processor requirements of each operation. As these figures show, all 
three tasks are demanding, reporting 100 percent processor utilization for significant lengths of time.  
 

 
 

Figure 9: Results for each of the four systems preparing slides for a customer presentation. Lower performance results are better. 
Higher comparative ratings are better. 
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Figure 10: System processor utilization of the Microsoft Excel 
subtotals background task running alone on the Intel Pentium 
4 630 Processor-based PC with HT Technology disabled. 

Microsoft PowerPoint file open
 (running alone, HT Technology disabled)

0

20

40

60

80

100

1 6 11
Seconds

Pr
oc

es
so

r 
ut

ili
za

tio
n

Figure 11: System processor utilization of the Microsoft 
PowerPoint file open foreground task running alone on the 
Intel Pentium 4 630 Processor-based PC with HT 
Technology disabled.
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Collaborating on product development 
This scenario opens an 11MB XML file in Word (the foreground task) while Webroot Spy Sweeper scans for 
spyware (the first background task) and Excel converts a 2.88MB spreadsheet to a PDF file (the second 
background task). As these tasks are executing, the user is on an Office Communicator 1:1 VoIP call. (We do not 
time this call, because the user, not the system controls its duration.) The tasks all run concurrently. 
Figure 13 shows the improvement in performance of the Intel vPro Technology-based PC with the Intel Core 2 
Duo Processor E6700 on both the foreground and background tasks relative to the Intel Pentium 4 630 
Processor-based PC. These results show that the Intel vPro Technology-based PC with the Intel Core 2 Duo 
Processor E6700 was 1.49 times faster on the foreground task, as well as 2.81 and 2.44 times faster on the two 
background tasks. The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 ran 1.21 
times faster on the foreground task than the Intel Pentium 4 630 Processor-based PC, 2.19 times faster on the 
first background task, and 1.74 times faster on the second background task. 

 
Both Intel vPro 
Technology-based 
PCs also outpaced 
the Intel Pentium D 
930 Processor-based 
PC, with the Intel vPro 
Technology-based PC 
with the Intel Core 2 
Duo Processor E6700 
averaging 1.70 times 
faster on the three 
tasks, and the Intel 
vPro Technology-
based PC with the 
Intel Core 2 Duo 
Processor E6300 
averaging 1.30 times 
faster. 
 
Figure 14 shows that 
these percentage 
differences mean 
valuable time savings 
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Figure 12: System processor utilization of the Microsoft 
PowerPoint change view foreground task running alone on Intel 
Pentium 4 630 Processor-based PC with HT Technology 
disabled. 

Figure 13: Performance, relative to the Intel Pentium 4 630 Processor-based PC, of each of the four 
systems collaborating on product development. Larger numbers represent better performance. 

Collaborating on product development
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6300 averages 66% faster 
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for users. Compared to the Intel Pentium 4 630 Processor-based PC, the Intel vPro Technology-based PC with 
the Intel Core 2 Duo Processor E6700 decreased the elapsed time from 12.5 to 8.4 seconds on the foreground 
task, from 69.5 to 24.7 seconds on the first background task, and from 294.9 to 120.7 seconds on the second 
foreground task. The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 also beat the 
Intel Pentium 4 630 Processor-based PC, with a 37.7-second edge on the first background task, a 125.2-second 
edge on the second background task, and a margin of 2.2 seconds on the foreground task. 
 

PERFORMANCE RESULTS (seconds) COMPARATIVE RATING 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

TASKS 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

12.5 11.4 10.3 8.4 

Microsoft Word 
Open XML file 
(FG) 1.00 1.10 1.21 1.49 

69.5 40.5 31.8 24.7 

Microsoft Excel 
spreadsheet to 
Adobe PDF 
conversion (BG) 1.00 1.72 2.19 2.81 

294.9 265.5 169.7 120.7 

Webroot Spy 
Sweeper scan 
(BG) 1.00 1.11 1.74 2.44 

 
 
The processor utilization curves in figures 15, 16, 17, and 18 give an overview of the demands the systems faced. 
In this scenario, the Office Communicator 1:1 VoIP call caused negligible load on the processor, but the 
background Webroot Spy Sweeper spyware scan wanted almost all of the processor, and the Excel PDF 
conversion put an appreciable additional load on the system. The processor requirements of the Word task varied 
but at times hit 100 percent. The Intel vPro Technology-based PCs with Intel Core 2 Duo Processors clearly 
handled this four-task load much better than the other two systems.  
 

Figure 14: Results for each of the four systems collaborating on product development. Lower performance results are better. 
Higher comparative ratings are better.  
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Figure 15: System processor utilization of the Webroot Spy 
Sweeper scan background task running alone on the Intel 
Pentium 4 630 Processor-based PC with HT Technology 
disabled. 
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Figure 16: System processor utilization of the Microsoft 
Excel spreadsheet to Adobe PDF conversion background 
task running alone on the Intel Pentium 4 630 Processor-
based PC with HT Technology disabled. 
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Collaborating on a marketing campaign presentation 
This scenario initiates a Microsoft Office Communicator 2005 whiteboard-sharing session (the foreground task) 
while Network Associates’ McAfee VirusScan performs a scan on a medium-large (164MB) directory (the first 
background task) and Microsoft Word opens an 8.18MB document with uncompressed graphics (the second 
background task). 
 
Figure 19 shows the improvement in performance of the Intel vPro Technology-based PC with the Intel Core 2 
Duo Processor E6700 on both tasks relative to the Intel Pentium 4 630 Processor-based PC. These results show 
the Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6700 was 1.41 times faster on the 
foreground task, 1.49 times faster on the first background task, and 1.52 times faster on the second background 
task. The Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 also yielded serious 
performance improvements, coming in at 1.13 times faster on the foreground task than the Intel Pentium 4 630 
Processor-based PC, 1.34 times faster on the first background task, and 1.47 times faster on the second 
background task. 
 
Both Intel vPro Technology-based PCs also outpaced the Intel Pentium D 930 Processor-based PC, with the Intel 
vPro Technology-based PC with the Intel Core 2 Duo Processor E6700 averaging 1.26 times faster on the three 
tasks, and the Intel vPro Technology-based PC with the Intel Core 2 Duo Processor E6300 averaging 1.12 times 
faster. 
 
Figure 20 shows that these differences represent significant improvements in the time it took to perform each 
task. Compared to the Intel Pentium 4 630 Processor-based PC, the Intel vPro Technology-based PC with Intel 
Core 2 Duo Processor E6700 decreased the time from 16.4 to 11.0 seconds on the first background task, from 
39.4 to 25.9 seconds on the second background task, and from 4.5 to 3.2 seconds on the foreground task. The 
Intel vPro Technology-based PC with Intel Core 2 Duo Processor E6300 also showed gains over the Intel 
Pentium 4 630 Processor-based PC, running 4.2 seconds faster on the first background task, 12.6 seconds faster 
on the second background task, and half a second faster on the foreground task. 
 
The processor utilization curves in figures 21, 22, and 23 help illustrate the reason for these time savings. As 
figure 21 shows, the McAfee virus scan task demands practically the full processor. The Microsoft Word file open  
 
 
 
 
 
 
 

Figure 17: System processor utilization of the Microsoft Office 
Communicator call task running alone on the Intel Pentium 4 
630 Processor-based PC with HT Technology disabled. 
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Figure 18: System processor utilization of the Microsoft Word 
open XML file foreground task running alone on the Intel 
Pentium 4 630 Processor-based PC with HT Technology 
disabled. 
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PERFORMANCE RESULTS (seconds) COMPARATIVE RATING 

Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

TASKS 
Intel 
Pentium 4 
630 
Processor-
based PC 

Intel 
Pentium D 
930 
Processor-
based PC 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6300 

Intel vPro 
Technology
-based PC 
with Intel 
Core 2 Duo 
Processor 
E6700 

4.5 4.0 4.0 3.2 

Microsoft Office 
Communicator start 
sharing (FG) 1.00 1.13 1.13 1.41 

16.4 14.5 12.2 11.0 
Microsoft Word file 
open (BG) 1.00 1.13 1.34 1.49 

39.4 31.7 26.8 25.9 
McAfee virus scan 
(BG) 1.00 1.24 1.47 1.52 

 
task (Figure 22) was fairly demanding as well and needed more than half of the processor. On top of that, even 
the light demand of the Microsoft Office Communicator whiteboard sharing task was enough to further load the 
system.  
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Figure 20: Results for each of the four systems collaborating on a marketing campaign presentation. Lower performance results 
are better. Higher comparative ratings are better.  
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Figure 21: System processor utilization of the McAfee virus 
scan background task running alone on the Intel Pentium 4 
630 Processor-based PC with HT Technology disabled. 

Microsoft Word file open
 (running alone, HT Technology disabled)

0

20

40

60

80

100

1 6 11 16 21 26
Seconds

Pr
oc

es
so

r 
ut

ili
za

tio
n

Figure 22: System processor utilization of the Microsoft 
Word file open background task running alone on the Intel 
Pentium 4 630 Processor-based PC with HT Technology 
disabled.
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Figure 23: System processor utilization of the Microsoft 
Office Communicator start sharing foreground task running 
alone on the Intel Pentium 4 630 Processor-based PC with 
HT Technology disabled.  
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Test methodology 
We evaluated the performance of each of the application scenarios (see “Application scenarios”) both by hand 
and with automated test scripts, which we developed with IBM’s Visual Test 6.5. Appendix B details the steps we 
followed when we hand-timed the scenarios. In this paper, we concentrate our discussions on the results of the 
automated scripts, because those results are generally more repeatable than hand timings.  
 
We collected results for five runs of each script in each system configuration. (If any test or script failed, we 
discarded that test’s results and ran the test again.) We refer in this paper only to the median results of those runs 
on each system configuration. The scripts produce times (in milliseconds), with lower times to complete a given 
function indicating better performance. We round those times to tenths of seconds in this report. 
 
Appendix A provides detailed configuration information on the test systems. We set up each of those systems 
using the following process: 
 

1. Install Microsoft Windows XP Professional. 
2. Using the standard Microsoft Windows Update Web site, apply all current (as of August 18, 2006) 

Windows XP critical updates, including Windows XP SP2—but not including optional updates, such as 
Windows Media Player 10 or Windows Media Connect, that were totally unrelated to the goal of this 
paper.  

3. Install Microsoft Office 2003 (with Access 2003). 
4. Using the standard Microsoft Office Update Web site, apply all current (as of August 18, 2006) Office 

2003 updates. 
5. Turn off Windows Service Pack 2 Security Center Pop-up Alerts. Doing so prevents such alerts from 

occurring during testing and affecting results. 
a. Open the system Control Panel. 
b. Choose Security Center. 
c. Click Change the way Security Center Alerts me on the left. 
d. Uncheck Firewall, Automatic Updates, and Virus Protection. 

6. Turn off Windows Automatic Updates. Doing so prevents such updates from occurring during testing and 
affecting results. 
a. Open the system Control Panel. 
b. Choose Automatic Updates. 
c. Select Turn off Automatic Updates. 

7. Turn off System Restore. Doing so prevents such events from occurring during testing and affecting 
results. 
a. Open the system Control Panel. 
b. Choose System. 
c. Choose the System Restore tab. 
d. Select Turn off System Restore on all drives. 

8. Turn off all Power Management settings. Doing so prevents such events from occurring during testing 
and affecting results. 
a. Open the system Control Panel. 
b. Choose Display. 
c. Choose the Screensaver tab. 
d. Select None as the Screensaver. 
e. Choose the Power button. 
f. Select the Power Schemes tab and choose Never to Turn off monitor, Turn off hard disks, and 

System standby. 
g. Select the Hibernate tab and uncheck the Enable Hibernation option. 

9. To ensure as consistent a starting point as possible for the performance measurements, defragment the 
hard disk of each system. 

10. Using Symantec’s Ghost utility, make an image of each system’s hard disk. (This image lets us return to a 
clean and consistent starting point whenever necessary.) 

11. Install the additional software, using the versions current as of August 18, 2006, that each scenario 
requires: 



 
15 

 
 

Principled Technologies, Inc.: System performance in common 
business multitasking collaboration and productivity-related scenarios 

• Sharing data for a sales report 
o Microsoft Office Communicator 2005 (Trial version) 
o Network Associates’ McAfee VirusScan Enterprise version 8.0i  

• Collaborating on product development 
o Adobe Acrobat 7.0 Standard Version 7.0.8 
o Microsoft Office Communicator 2005 (Trial version)  
o Webroot Spy Sweeper version 4.5.9 (build 709) using Spyware Definitions v 745 (14-day trial)  

• Collaborating on a marketing campaign presentation 
o Microsoft Office Communicator 2005 (Trial version)  
o Network Associates’ McAfee VirusScan Enterprise version 8.0i  
 

In addition to the test systems, the two scenarios that use Office Communicator require the following additional 
systems: 
 

• a Live Communications server 
• a client system to serve as an Office Communicator contact for the system under test 
• only in the scenario that includes a 1:1 VoIP call, a monitoring station to supply the audio for the call 

 
Figure 24 shows the systems and connections that both of these Office Communicator scenarios require. The 
collaborating on product development scenario includes a VoIP call and requires an additional system to provide 
audio for that call; we discuss that system in the instructions for that scenario. 
 

 
Figure 24: System configuration for the scenarios that involve Office Communicator. 

The server running the Live Communications Server software must be part of a domain with Active Directory 
running. (During the installation of Active Directory, you must perform the Prep Schema, Prep Forest, and Prep 
Domain functions.) For some of the email functions to work properly, the scenarios also require an Exchange 
Server. To simplify setup, a single server can act as a Domain Controller with Active Directory, Application Server 
(IIS), DNS, and Exchange Server all running.  
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After you properly set up these applications or services, the final task is to set up Live Communications Server. 
The following steps, which assume those other server applications are already running, provide an overview of 
the process of installing and configuring Live Communications Server. For more details, consult the appropriate 
Microsoft documentation. 
 

1. Install Live Communications Server with the default installation options.  
2. Activate Live Communication Server. 
3. Use TCP as the connection protocol. 
4. The scenarios require one user for each system in the test. Add those users first within Active Directory. 
5. After you create the users in Active Directory, right-click each user name, and select Properties. 

o In the Properties window, select the Live Communications tab.  
o Place a check in the Enable Live Communications for this user check box.  
o In the SIP URL, enter the user name.  
o Select this server pool (in a clean test setup, there should be only one) from the drop-down 

menu, and click Apply. 
o Repeat the above steps for each test user. 

6. Close the Active Directory window. 
7. Once you have enabled the users for Live Communication, you should be able to see them in the Live 

Communications Server window in the Users folder.  
8. Each of the systems should be able to log into the server with its appropriate user account.  

 
Each of the systems you use in the test must be running Microsoft Office Communicator 2005. The following 
steps, which assume you’ve already set up the server, provide an overview of the process of installing and 
configuring Office Communicator. For more details, consult the appropriate Microsoft documentation. 
 

1. Before installing the software, edit the Hosts file in C:\Windows\system32\drivers\etc\ so that the file 
includes the server’s name and IP address.  

2. Install Office Communicator 2005 using all the default options.  
3. After the installation is complete, open Office Communicator. 
4. Choose Options from the Actions drop-down menu.  
5. In the Accounts tab, enter the user name for this system.  
6. Click the Advanced Options button.  
7. In the Advanced Connection Settings window, choose Configure Settings. 
8. Enter the server name in the appropriate line.  
9. Use TCP as the connection setting.  
10. Close both the Advanced and Option windows.  

 
To sign in to the Office Communicator server before testing, do the following: 
 

1. Select Sign In from the Connect drop-down menu.  
2. When the Sign-In Name window appears, enter the user name. 
3. Click OK.  
4. In the next window, enter the password. 
5. Select Save Password.  

 
To obtain the results for each application scenario, we followed the same basic process: 
 

1. Reboot the system. 
2. Wait 10 seconds after the Windows hourglass disappears and Windows XP has completed its startup 

sequence. This delay ensures the system is in a consistent starting state.  
3. Run the test script or hand-timed application functions, as appropriate. 
4. Record the results. 
5. Repeat the above three-step process five times.  

 
If any test or script failed, we discarded that test’s results and ran the test again. 



 
17 

 
 

Principled Technologies, Inc.: System performance in common 
business multitasking collaboration and productivity-related scenarios 

 

Appendix A – Test system configuration information 
This appendix provides detailed configuration information about each of the test systems, which we list in 
alphabetical order by processor name. 
 

Processors in the 
systems 

Intel Pentium 4 
630 Processor-

based PC 

Intel Pentium D 
930 Processor-

based PC 

Intel vPro 
Technology-

based PC with 
Intel Core 2 Duo 
Processor E6300 

Intel vPro 
Technology-

based PC with 
Intel Core 2 Duo 
Processor E6700 

General 
Processor and OS kernel: 
(physical, core, logical) / 
(UP, MP) 

1P1C2L / MP 1P2C2L / MP 1P2C2L / MP 1P2C2L / MP 

Number of physical 
processors 1 1 1 1 

Single/Dual-Core 
processors 

Single (with 
Hyper-Threading 

Technology 
enabled) 

Dual/None Dual/None Dual/None 

System Power 
Management Policy Home/Office Desk Home/Office Desk Home/Office Desk Home/Office Desk 

CPU 
System type Intel Intel Intel Intel 
Vendor Pentium 4 Pentium D Core2Duo Core2Duo 

Name 630 930 E6300 
(pre-production) 

E6700 
(pre-production) 

Stepping 3 2 5 5 
Socket type LGA775 LGA775 LGA775 LGA775 
Core frequency (GHz) 3.0 3.0 1.86 2.66 
Front-side bus frequency 
(MHz) 800 MHz 800 MHz 1066 MHz 1066 MHz 

L1 Cache 16 KB + 12 Kµops 16 KB + 12 Kµops 32 KB + 32 KB 32 KB + 32 KB 
L2 Cache 2 MB 2 MB 2 MB 4 MB 
Platform 
Vendor Intel Intel Intel Intel 
Motherboard model 
number D945GTP D945GTP DQ965WC DQ965WC 

Motherboard chipset Intel i945G 
Express 

Intel i945G 
Express 

Intel Q965 
Express 

(pre-production) 

Intel Q965 
Express 

(pre-production) 
Motherboard revision 
number A2 A2 01 01 

Motherboard serial 
number AAC97837-301 AAC97837-301 AAD41834-300 AAD41834-300 

BIOS name and version 

Intel 
NT94510J.86A.39
43.2006.0707.140

5 

Intel 
NT94510J.86A.39
43.2006.0707.140

5 

Intel 
CO96510J.86A.44
62.2006.0804.205

9 

Intel 
CO96510J.86A.44
62.2006.0804.205

9 
BIOS settings AHCI Enabled AHCI Enabled AHCI Enabled AHCI Enabled 
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Memory module(s) 
Vendor and model 
number 

Micron 
8HTF6464AY-

667D7 

Micron 
8HTF6464AY-

667D7 

Corsair CM2X512A-
6400 

Corsair CM2X512A-
6400 

Type PC5300 PC5300 PC6400 PC6400 
Speed (MHz) 667 667 800 800 
Speed in the system 
currently running @ 
(MHz) 

333 333 400 400 

Timing/Latency (tCL-
tRCD-tRP-tRASmin) 5-5-5-15 5-5-5-15 5-5-5-12 5-5-5-12 

Size 1 GB 1 GB 1 GB 1 GB 
Number of sticks 2 x 512 MB 2 x 512 MB 2 x 512 MB 2 x 512 MB 
Chip organization Double-sided Double-sided Double-sided Double-sided 
Channel Dual Dual Dual Dual 
Hard disk 
Vendor and model 
number Maxtor 6B300S0 Maxtor 6B300S0 Maxtor 6B300S0 Maxtor 6B300S0 

Size 300 GB 300 GB 300 GB 300 GB 
Buffer Size 16 MB 16 MB 16 MB 16 MB 
RPM 7200 7200 7200 7200 
Type SATA 150 MB/s SATA 150 MB/s SATA 150 MB/s SATA 150 MB/s 

Controller Intel 82801GB 
(ICH7) 

Intel 82801GB 
(ICH7) 

Intel 82801HB 
(ICH8) 

Intel 82801HB 
(ICH8) 

Driver Intel 5.5.0.1035 Intel 5.5.0.1035 Intel 6.1.0.1002 Intel 6.1.0.1002 
Operating system 

Name Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Build number 2600 2600 2600 2600 
Service pack 2 2 2 2 
Microsoft Windows 
update date NTFS NTFS NTFS NTFS 

File system ACPI 
Multiprocessor PC 

ACPI 
Multiprocessor PC 

ACPI 
Multiprocessor PC 

ACPI 
Multiprocessor PC

Kernel English English English English 
Language DirectX 9.0c DirectX 9.0c DirectX 9.0c DirectX 9.0c 

Microsoft DirectX version Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Graphics 
Vendor and model 
number Intel GMA 950 Intel GMA 950 Intel GMA 3000 Intel GMA 3000 

Chipset Integrated Integrated Integrated Integrated 

BIOS version Intel 82945G 
Express Chipset 

Intel 82945G 
Express Chipset 

Intel Q965 
Express Chipset 

Intel Q965 
Express Chipset 

Type 1295 1295 1345 1345 
Memory size 128 MB Shared 128 MB Shared 128 MB Shared 128 MB Shared 
Resolution 1024 x 768 1024 x 768 1024 x 768 1024 x 768 
Driver Intel 6.14.10.4497 Intel 6.14.10.4497 Intel 6.14.10.4624 Intel 6.14.10.4624 
Sound card/subsystem 
Vendor and model 
number 

SigmaTel High 
Definition Audio 

SigmaTel High 
Definition Audio 

SigmaTel High 
Definition Audio 

SigmaTel High 
Definition Audio 
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Driver SigmaTel 
5.10.5067.0 

SigmaTel 
5.10.5067.0 

SigmaTel 
5.10.5067.0 

SigmaTel 
5.10.5067.0 

Ethernet 
Vendor and model 
number 

Intel PRO/1000 
PM 

Intel PRO/1000 
PM 

Intel 82566DM 
Gigabit 

Intel 82566DM 
Gigabit 

Driver Intel 9.4.17.0 Intel 9.4.17.0 Intel 9.4.6.0 Intel 9.4.6.0 
Optical drive(s) 
Vendor and model 
number 

Lite-On DVDRW 
SHOW-1673S 

Lite-On DVDRW 
SHOW-1673S 

Slimtype DVDRW 
SLW-8315 

Slimtype DVDRW 
SLW-8315 

Type DVD-RW DVD-RW DVD-RW DVD-RW 
Dual/Single layer Dual Dual Dual Dual 
USB ports 
Number 6 6 8 8 
Type USB 2.0 USB 2.0 USB 2.0 USB 2.0 
IEEE 1394 ports 
Number 1 1 2 2 
Monitor 
Type Plug & Play Plug & Play Plug & Play Plug & Play 

 
Figure 25: Detailed system configuration information for each of the four test systems. 

 



 
20 

 
 

Principled Technologies, Inc.: System performance in common 
business multitasking collaboration and productivity-related scenarios 

Appendix B – Instructions for running the application scenarios 
This appendix summarizes the script for each application scenario and explains how we manually tested and 
timed each of those scenarios. Though the vast majority of our discussions in this report focus on the results of 
the automated tests, we verified that manually performing the same functions yielded results similar to those of 
the automated scripts. 
 
As the instructions below reflect, to get the most consistent possible timings and to make our hand-timed actions 
more like the ones the automated scripts perform, we sometimes chose to follow procedures for launching 
applications that were different from those typical users would follow. (See Appendix C for additional information 
on scripting issues.) When we made such choices, we also independently verified that the typical user procedures 
would still show similar results.  
 
Consequently, we are confident that the performance benefits the Intel vPro Technology-based PCs delivered in 
these scenarios are benefits that users can expect to realize in real work situations and are not artifacts of the 
measurement or scripting technology. 
 
We ran all application scenarios five times on each of the four systems under test, and we reported the median of 
those runs. Each time we reboot the system, we wait 10 seconds after the last hourglass has disappeared to 
make sure the system is in a consistent state. 
 
The following subsections, which assume you have already completed all of the setup work in the Test 
Methodology section, describe how to run each of the individual scenarios.  

Sharing data for a sales report 
The applications involved 

• Microsoft Office Communicator 2005 (Trial version) 
• Microsoft Office Excel 2003 (Service Pack 2) 
• Microsoft Office Outlook 2003 (Service Pack 2) 
• Network Associates’ McAfee VirusScan Enterprise version 8.0i  

The data files involved 
• Excel2MinMacro.xls, a formula-rich 2.56MB Excel file 
• Sales2002a.XML, a 68.5MB XML report we created from an Access database 

The script 
This scenario requires two scripts: one for the system under test, and one for the system that receives the file the 
system under test sends via Microsoft Office Communicator. We start the script for the receiving system first. That 
script waits until the system under test sends a message requesting permission to send the file, waits 8 seconds 
(the time a real user might take to read and consider the message), and then accepts the request.  
 
The script for this scenario performs the following tasks on the system under test: 
 

1. Open Excel2MinMacro.xls. 
2. In Office Communicator, select Actions > More > Send a File. 
3. Highlight the contact you want to send the file to. 
4. Press OK. 
5. In the Send a File dialog, find and select Sales2002a.XML. (We did not time these first five tasks, 

because they occur outside the multitasking section of the script.) 
6. Start the timer for the first background task. (Add 8 seconds to the timer, because the receiving system 

will wait 8 seconds before agreeing to accept the file, and the task does not start until the receiving 
system agrees to accept the file.).  

7. Click the Open button in the Send a file dialog in Office Communicator. 
8. On the Office Communicator window, select Actions > Send E-Mail. 
9. Highlight the first contact.  
10. Start the timer for the second background task, and press F9 in Excel to start the manual calculation. 
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11. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 
before moving to another. 

12. Start the timer for the foreground task, and press OK on the Send email dialog.  
13. Wait 3 seconds. This delay mimics the time a typical user might wait after confirming one task has started 

before moving to another. 
14. At this point the receiving system is accepting the file, so a progress bar for the send file task displays on 

both systems. 
15. Stop the timer for the first background task when the send file progress bar goes away.  
16. Stop the timer for the foreground task when the system displays the Untitled Message addressed to the 

contact you selected for this message. 
17. Stop the timer for the second background task when the Excel manual calculation finishes, which is when 

the Excel status bar says Ready. 
18. Close Excel without saving the file, and close all but the main Office Communicator window. (We did not 

time these tasks, because they occur outside the multitasking section of the script.) 
 

 
The script for the receiving system performs the following tasks on that system: 
 

1. Wait until the system under test sends a message via Office Communicator requesting permission to 
send a file. 

2. Wait 8 seconds, and accept that request. Office Communicator on the system under test then sends the 
file.  

The manual process 
In addition to the system under test, this scenario requires a second system that is also running Office 
Communicator 2005. The second system will receive the file that the test system sends. The process for setting 
up that system is the same as for setting up the test systems.  
 
First, prepare each system by following these steps once: 
 

1. Open Office Communicator. 
2. Select Contacts > Add Contact to open the Contacts Setup wizard. 
3. Enter the user name of the system you will be calling during testing.  
4. Select Next through the remaining wizard options, thus keeping the defaults for each one. 
5. Select Contacts > Add Contact to open the Contacts Setup wizard. 
6. Enter the user name of an offline system you will be calling during testing. (This must be the second 

contact name.) 
7. Select Next through the remaining wizard options, thus keeping the defaults for each one. 
8. Copy Sales2002a.XML to the desktop. 
9. Create a desktop shortcut to Excel2MinMacro.xls. 
10. Make sure you have set up Outlook with the same user name as the one you’re using for Office 

Communicator. 
11. Open Outlook. 
12. Make sure Outlook has HTML and Word as formats for email messages. 
13. Put Excel into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
14. Position the Excel window so it does not overlap the Office Communicator window. 
15. Close Excel and Outlook. 

 
To execute the test, follow these instructions. You will need two stopwatches. 
 

1. Reboot both systems.  
2. On the system that is going to receive the file, set the Office Communicator status to Online. 
3. On the system under test,  

a. Open the Excel spreadsheet. 
b. In Office Communicator, select Actions > More > Send a File. 
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c. Highlight the contact you want to send the file to; it should be the receiving system. 
d. Click OK. 
e. In the Send a File dialog, click Desktop. 
f. Select Sales2002a.XML. 
g. Click the Open button. 
h. In the Office Communicator window, select Actions > Send E-Mail. 
i. Highlight the offline contact. 

4. Go to the system that is going to receive the file, and accept the file. A confirmation window will appear. 
Leave that window in place. 

5. Go back to the system under test. 
6. To make it easier to get times, we included in the Excel file a macro that runs the manual calculation and 

shows the elapsed time on the Excel status bar. Start the macro by pressing Alt-a. If you prefer to time 
the task with a stopwatch, press F9 to start the manual calculation, and start the stopwatch. 

7. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 
before moving to another. 

8. Press OK on the Send email dialog. Start the stopwatch for the send email task.  
9. Wait 3 seconds. This delay mimics the time a typical user might wait after confirming one task has started 

before moving to another. 
10. Go to the system receiving the file you're sending. Click OK on the confirmation window, and start the 

stopwatch for the send file task. A green progress bar displays. 
11. The send file task is done when the green progress bar goes away. Stop the timer for the send file task 

then. 
12. On the system under test, stop the timer for the send email task when the system displays the Untitled 

Message addressed to the contact you selected for this message. 
13. If you pressed F9 to start the Excel manual calculation, the task is done when the spreadsheet status bar 

says Ready, so stop the stopwatch then. If you used the macro, it displays in the Excel status bar the 
elapsed time for the calculation. 

14. Close Excel without saving the file. 
15. Close all but the main Office Communicator window. 

Preparing slides for a customer presentation 
The applications involved 

• Microsoft Office Excel 2003 (Service pack 2) 
• Microsoft Office PowerPoint 2003 (Service pack 2) 

The data files involved 
• Content.ppt, a 33.5MB PowerPoint presentation  
• Sales2002a1.xls, a 1.79MB spreadsheet 

The script 
The script for this scenario performs the following tasks: 
 

1. Open Sales2002a1.xls. 
2. Select Data>Subtotals from the Excel menu 
3. Fill in the Subtotal dialog as follows: 

• In the At each change in: box, select Size. 
• In the Use function: box, select Sum. 
• In the Add subtotal to: box, check Quantity, and make sure nothing else is checked. 
• Remove the checkmark for Replace current subtotals. 

 (We did not time these first three tasks because they occur outside the multitasking section of the script.) 
4. Start the timer for the background Excel task, and press OK. 
5. Start the timer for the first foreground task, and open Content.ppt. 
6. Stop the timer for the foreground task when PowerPoint has finished opening Content.ppt. 
7. Start the timer for the second foreground task, and select View\Slide Sorter in PowerPoint. 
8. Stop the timer for the second foreground task when PowerPoint displays all the slide images. 
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9. Stop the timer for the background task when the Excel progress bar goes away.  
10. Close Excel and PowerPoint. (We did not time these two tasks because they occur outside the 

multitasking section of the script.) 

The manual process 
First, prepare each system by following these steps once: 
 

1. Start PowerPoint 2003. 
2. Put PowerPoint into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
3. Position the PowerPoint window on the right side of the screen.  
4. Exit PowerPoint. 
5. Start Excel 2003. 
6. Put Excel into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
7. Position the Excel window on the left side of the screen.  
8. Exit Excel. 
9. Create a shortcut to Sales2002a1.xls on the desktop. Position the shortcut icon on the left side of the 

screen. 
10. Create a shortcut to Content.ppt on the desktop. Position the shortcut icon on the left side of the screen. 

 
To execute the test, follow these instructions. You will need three stopwatches. 
 

1. Reboot the system. 
2. Open Sales2002a1.xls using the desktop shortcut you created. 
3. Select Data/Subtotals from the Excel menu. 
4. Fill in the Subtotal dialog as follows: 

• In the At each change in: box, select Size. 
• In the Use function: box, select Sum. 
• In the Add subtotal to: box, check Quantity and make sure nothing else is checked. 
• Remove the checkmark for Replace current subtotals. 

5. Start the stopwatch, and press OK. 
6. Start the second stopwatch and double-click the Content.ppt desktop shortcut. 
7. Stop the second stopwatch when PowerPoint has finished opening Content.ppt. 
8. Start the third stopwatch, and select View>Slide Sorter from the PowerPoint menu. 
9. Stop the third stopwatch when PowerPoint displays all the slide images. 
10. Stop the first stopwatch when the Excel progress bar goes away. 
11. Close Excel and PowerPoint. 

Collaborating on product development 
The applications involved 

• Adobe Acrobat Standard 7.0.8 
• Microsoft Office Communicator 2005 (trial version)  
• Microsoft Office Excel 2003 (Service Pack 2) 
• Microsoft Office Word 2003 (Service Pack 2) 
• Webroot Spy Sweeper version 4.5.9 (build 709) using Spyware Definitions v 745 (14-day trial)  

The data files involved 
• Excel2MinMacro.xls, a formula-rich 2.88 MB Excel file 
• ProjectA1.XML, an 11 MB XML document with pictures and graphics. 

The script 
The tester starts a call in Office Communicator by hand and then launches the script. The script for this scenario 
performs the following tasks: 
 

1. Open Excel2MinMacro.xls.  
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2. Select Adobe PDF > Convert to Adobe PDF from the Excel menu. The Save Adobe PDF File As dialog 
displays.  

3. Open Spy Sweeper, and select the Sweep Now button. (We did not time these first three tasks because 
they occur outside the multitasking section of the script.) 

4. Start the timer for the first background task, and select the Start button to start the Spy Sweeper 
background task.  

5. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 
before moving to another 

6. Start the timer for the second background task, and select Save on the Save Adobe PDF File As dialog, 
7. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 

before moving to another 
8. Start the timer for the foreground task, and open ProjectA1.XML. 
9. Stop the timer for the foreground task when Word displays ProjectA1.XML and the page counter in the 

Word status bar shows 1/10. 
10. Stop the timer for the second background task (Acrobat conversion) when Adobe Acrobat opens and 

displays the PDF file. 
11. Stop the timer for the first background task when the Spy Sweeper status window reports that the scan is 

done. 
12. Exit all open applications. (We did not time these tasks because they occur outside the multitasking 

section of the script.) 

The manual process 
First, prepare each system by following these steps once: 
 

1. Open Spy Sweeper.  
2. Select the Options button. 
3. On the Program Options tab, uncheck all checkboxes except Load at Windows Startup. 
4. On the Sweep Options tab, uncheck all checkboxes, and select the radio button for Only Sweep Folders 

Where Threats Are Known to Reside. 
5. Start Word. 
6. Put Word into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
7. Position the Word window so it fills up the upper-right quarter of the screen.  
8. Start Excel. 
9. Put Excel into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
10. Position the Excel window over the Word window.  
11. Open Acrobat. 
12. Put Acrobat into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
13. Position the Acrobat Window in the upper-left quarter of the screen.  
14. Create a desktop shortcut to Excel2MinMacro.xls. 
15. Create a desktop shortcut to ProjectA1.XML. 
16. Close Word, Excel, and Acrobat. 
17. Open Office Communicator 
18. Select Contacts > Add Contact to open the Contacts Setup wizard. 
19. Enter the user name of the system you will be calling during testing.  
20. Select Next through the remaining wizard options, thus keeping the defaults for each one. 
21. After you’ve finished adding the contact, close Office Communicator. 
22. To send the voice sample through the VoIP 1:1 call during the test, you will need an additional system, 

which we call the monitoring station, that is not otherwise part of this test.  
a. The monitoring station will need to contain the female test voice file that it will play during the test. 
b. Connect the monitoring station to the system under test with an audio cable. The audio cable 

should run from the speaker out port of the monitoring station to the microphone input port on the 
system under test. This arrangement enables the monitoring station to mimic someone speaking 
into a microphone during the Office Communicator voice call. 

c. The monitoring station will also capture and monitor the audio that the other call participant 
receives. To enable it to do that, connect a stereo cable from the speaker out port of the system 
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Figure 26: System configuration for the Microsoft Office Communicator 2005 voice call in the collaborating on product 
development scenario. 

receiving the call (the 1:1 Call Participant in the diagram below) to the line in port of the 
monitoring station. 

23. Figure 26 shows the systems and connections this scenario requires.  

 
 
 
 
To execute the test, follow these instructions. You will need two stopwatches. 
 

1. Reboot the system under test and the 1:1 call participant system. 
2. Start the VoIP 1:1 call between the systems by opening Office Communicator on the system under test. 
3. In the Office Communicator window, right-click the contact you want to call. This action opens a Selection 

menu.  
4. Choose Call.  
5. On the system receiving the call, click Accept to begin the call between the two computers.  
6. After Office Communicator has established the call, begin playing the voice sample on the monitoring 

station so the voice sample plays throughout the call.  
7. Double-click the Excel2MinMacro.xls desktop shortcut.  
8. Select Adobe PDF > Convert to Adobe PDF from the menu. The Save Adobe PDF File As dialog 

displays. 
9. Open Spy Sweeper, and select the Sweep Now button. 
10. Select the Start button to start the Spy Sweeper background task. Spy Sweeper will report the elapsed 

time for the scan, so you do not need to stopwatch this task. 
11. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 

before moving to another 
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12. Select Save on the Save Adobe PDF File As dialog, and start a stopwatch for this second background 
task. 

13. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 
before moving to another. 

14. Double-click the ProjectA1.XML desktop shortcut, and start a stopwatch for this foreground task. 
15. Stop the stopwatch for the XML open foreground task when Word displays the file and the page counter 

in the Word status bar shows 1/10. 
16. Stop the stopwatch for the Acrobat conversion background task when Adobe Acrobat opens and displays 

the PDF file. 
17. Get the time for the Spy Sweeper task from the status box at the bottom of its window. 
18. Exit Acrobat, Excel, Word, and Spy Sweeper. 
19. Stop the Office Communicator 1:1 call by clicking the red square in the Call window. 
20. Delete the PDF file you created. 

Collaborating on a marketing campaign presentation 
The applications involved 

• Microsoft Office Communicator 2005 (Trial version)  
• Microsoft Office Word 2003 (Service Pack 2) 
• Network Associates’ McAfee VirusScan Enterprise version 8.0i  
• Adobe Acrobat 7.0 Version 7.0.8  

The data files involved 
• C:\Program Files\Adobe\Acrobat 7\Setup Files\AcroStan\ENU, a 164MB folder. To keep the script time 

reasonable, we scanned only this one folder. The folder contains a large compressed (CAB) file and an 
installer file. 

• ProjectA1.doc, an 8.18MB Word document with uncompressed pictures 

The script 
The script for this scenario performs the following tasks: 
 

1. Select Actions > More > Start Sharing… in the Office Communicator window. This window opens 
automatically when you boot your system. 

2. Highlight the first contact on the Start Sharing dialog that displays. 
3. Open the VirusScan console. 
4. Select the Acrobat scan task. (We did not time these first four tasks because they occur outside the 

multitasking section of the script.) 
5. Start the timer for the first background task, and click Start.  
6. Wait 5 seconds. This delay mimics the time a typical user might wait after confirming one task has started 

before moving to another 
7. Start the timer for the second background task, and open ProjectA1.doc. 
8. Wait until Word displays the document title in its Window, start the timer for the foreground task, and then 

click the OK button on the Start Sharing window.  
9. Stop the timer for the foreground task when Office Communicator opens a Conversation window that 

shows an instant message saying your contact is being invited to the data sharing session.  
10. Stop the timer for the second foreground task when the Word document status bar shows a page count of 

1/42. 
11. Stop the timer for the first background task when the VirusScan status window shows that the scan is 

done. 
12. Exit Word, the Office Communicator Conversation window, and the VirusScan Console. (We did not time 

these tasks because they occur outside the multitasking section of the script.) 

The manual process 
First, prepare each system by following these steps once: 
 

1. Start Word. 
2. Put Word into windowed mode, if necessary, by clicking the Restore Down button in the upper right. 
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3. Position the Word window so it takes up roughly the right half of the screen horizontally and the middle 
two-thirds vertically.  

4. Exit Word. 
5. Start the McAfee VirusScan Console from the Start menu. 
6. Position the Console on the upper right side of screen. Leave room above it for a row of icons. 
7. Select Task > New On-Demand Scan Task. 
8. Name the task Acrobat.  
9. The VirusScan On-Demand Scan Properties – Acrobat dialog appears. If it does not, right-click the 

Acrobat task name. 
10. Click Remove twice to remove the two item names in the list box on that dialog. Click Yes on the confirm 

dialog that appears after each deletion. 
11. Click Add, and scroll down to Drive or Folder. 
12. Click Browse, and browse to C:\Program Files\Adobe\Acrobat 7\Setup Files\AcroStan\ENU. 
13. Click OK to close the Browse for Folder dialog. 
14. Click OK to close the Add Scan Item dialog. 
15. Click the Detection tab. 
16. Check the two checkboxes under Compressed Files. 
17. Click OK. 
18. Exit VirusScan Console. 
19. Office Communicator should load on system startup. Position its window on the left side of the screen. 
20. In the upper right corner of the screen, create a desktop shortcut to ProjectA1.doc. 
21. In the upper right corner of the screen, create a desktop shortcut to the VirusScan Console. 

 
To execute the test, follow these instructions. You will need two stopwatches. 
 

1. Reboot the system. 
2. Select Actions > More > Start Sharing… in the Office Communicator window that automatically appears. 
3. Highlight the first contact on the Start Sharing dialog that displays. 
4. Open the VirusScan console using its desktop shortcut. 
5. Select the Acrobat scan task. 
6. Click Start. You do not need a stopwatch for this task because VirusScan reports the elapsed time. 
7. Move the Scan Progress window to the lower right corner of screen, and wait until the scan time is at five 

seconds (the time displays in the status bar at bottom of the Scan Progress window). This delay mimics 
the time a typical user might wait after confirming one task has started before moving to another. 

8. Double-click the ProjectA1.doc desktop shortcut, and start the stopwatch for this second background 
task. 

9. Wait until Word displays the document title in its Window, and then immediately click the OK button on the 
Start Sharing window. Start the stopwatch for the Office Communicator foreground task when you click 
that button. 

10. Stop the Office Communicator task stopwatch when Office Communicator opens a Conversation window 
that shows an instant message saying your contact is being invited to the data sharing session. The 
window usually pops up without this message and then after a short delay redraws with Instant Message 
and Sharing Controls. 

11. If the Word document does not have focus, click it. 
12. Stop the stopwatch for the Word background task when the Word document status bar shows a page 

count of 1/42. 
13. The status bar in VirusScan gives you the elapsed time for that first background task.  
14. Exit Word, the Office Communicator Conversation window, and the VirusScan Console. 
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Appendix C – Issues in script development  
To the best of our knowledge, despite its age IBM’s Visual Test 6.5 remains the tool most widely used today for 
constructing application-based benchmarks and performance tests for PCs running various versions of Microsoft 
Windows. We have used this product (and previous versions of it) for many years to build performance tests. The 
tool does, however, have some stated limitations that unavoidably affect the way one develops performance tests 
with it.  
 
First, the product’s own documentation notes that its primary goal is to be a tool for automating application testing, 
not a benchmark development system. Consequently, the granularity of some of its functions and the way some 
of its functions behave are not ideal for benchmark development. 
 
IBM also does not officially support Visual Test 6.5 for the Windows XP operating system. Because Windows XP 
is the leading and most current desktop version of Windows today, we nonetheless felt it was essential to use that 
operating system in our tests.  
 
The presence of any scripting tool has the potential to affect the performance of a system. The tool unavoidably 
must, for example, occupy some memory and consume some processing power. Consequently, developing a 
performance-measurement script with such a tool involves maintaining a delicate balance between using the tool 
to automate typical real user behavior and minimizing the effects of the tool on system performance. To make 
sure the results of our scripts were accurate, we also hand-timed each of the functions we scripted. 
 
To minimize these limitations and problems, we sometimes had to use scripting techniques that would achieve 
the same results as typical user behavior but not exactly mirror that behavior. Such techniques include inserting 
delays to mimic user think time and launching applications with a click on the OK button of a pre-filled Run 
command line. The hand timing instructions we provide in Appendix B reflect those techniques, so following those 
instructions will yield results similar to those the scripts produce. Whenever we had to use one of these alternative 
techniques, we manually verified that doing so did not materially alter the way the system behaved and that real 
users performing the same actions in more typical ways would see the type of dual-core processor technology 
benefits that we describe.  
 
The timings the scripts produce also inevitably contain some variability. This variability is a result of the 
combination of the tool’s limitations and the generally asynchronous nature of the many processes Windows XP 
and other modern operating systems have running at any given time.  
 
Finally, though one of the goals of this effort was to produce reliable scripts, we were not trying to build bulletproof 
benchmarks for wide distribution and use. We developed the scripts to mimic user behavior on our specific test 
systems; on different systems the scripts might show different levels of benefit from a dual-core processor or even 
fail to work. So, although the scripts are as reliable, self-contained, and free of system dependencies as we could 
reasonably achieve within the project’s timeframe, they do sometimes fail or encounter problems. Should a 
problem occur, rebooting the system and running the script again will generally yield a good result. 
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Disclaimer of Warranties; Limitation of Liability: 
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS 
TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR 
IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING 
ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE 
RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS 
EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE 
ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.  
 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE 
AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE 
REMEDIES ARE AS SET FORTH HEREIN. 

 

Principled Technologies, Inc. 
4813 Emperor Blvd., Suite 100 

Durham, NC 27703 
www.principledtechnologies.com 
info@principledtechnologies.com 

Principled Technologies is a registered trademark of Principled Technologies, Inc. 
Intel, the Intel Logo, Core, Pentium, and vPro are trademarks or registered trademarks of Intel Corporation or its 
subsidiaries in the United States and other countries. All other product names are the trademarks of their 
respective owners. 
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